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The small print 

Prerequisites 
Time in the workshop is precious – it is an opportunity for you to interact with the workshop 
leader and other participants through questions and discussions and to share your 
experiences and concerns. To make the most of this time we sometimes ask you to carry out 
learning activities ahead of the workshop so that everyone comes into the class with the 
same basic knowledge. We keep this prior learning to a minimum and often make use of 
online videos. Online videos provided through LinkedIn Learning can be accessed free of 
charge by University members anytime, anywhere, through a browser or app. 

Your course booking will tell you if any prior learning activity is required. If you don’t have an 
environment where you can do this learning, you can come along to one of our LinkedIn 
Learning sessions. These are a quiet space where you can work through videos or other 
workshop resources. 

If you arrive for a workshop without having done the prior learning, the workshop leader may 
suggest that you come back on another session.  

Copyright 
Pamela Stanworth makes this booklet and the accompanying slides available under a 
Creative Commons licence (BY-NC-SA: Attribution-NonCommercial-ShareAlike). 

The Oxford University crest and logo and IT Services logo are copyright of the University of 
Oxford and may only be used by members of the University in accordance with the 
University’s branding guidelines. 

The Wollstonecraft document was sourced from Project Gutenberg and is available in the 
public domain. 

About the workshop designer 
Pamela Stanworth has over a decade’s experience working on formal documents, theses and 
reports with researchers and departments across the University. She brings a pragmatic 
approach to building documents that are effective, reliable and sustainable. 

Pamela’s roots are in engineering, working with blue-chip industrial companies, technical 
consultancy and small businesses. Her commitment in teaching and consulting is to enable 
people to use appropriate technology in their work, efficiently and to a high standard. 

Revision history 
Version Date Author Comments 

1.0 September 2016 Stephen Eyre  

2.0 August 2018 Pamela Stanworth Review exercises 

2.1 December 2018 Pamela Stanworth Updates 

3.0 May 2020 Pamela Stanworth Revise for online 

4.0 September 2022 Pamela Stanworth New courser title 

4.1 October 2023 Pamela Stanworth Reformat 

 



  

 

  



  

 

About this workshop 

This workshop gives you an insight into some of the techniques that are available in Word, to 
help you create organized large documents such as a thesis. It will reinforce the key concept 
of using each tool to its strength and allowing the word processor to organize your work for 
you according to your goals. 

What you will learn 
Using automated tools provided in Word, you will learn how to generate key lists that are 
integral to formal longer documents such as indexes, tables of illustrations and contents. You 
will see how to apply the popular styles structure to a formal document, with automatic 
numbering for a hierarchy of headings. 

There will be some time to work through prepared exercises or to experiment with your own 
document. 

We will include pointers to other workshops and further resources that will help you go on 
later to create and manage documents. 

What you need to know 
The workshop is designed to work with Word as this is commonly used for academic writing 
at Oxford. Many of the concepts will be transferable to other word processors though and the 
key concepts are useful whatever word processor is to be used. 

I will assume that you are reasonably confident in using Word and can: 

 Use heading styles 

 Understand sections 

 Use headers and footers 

If you need to review these activities, LinkedIn Learning is a great place to get guidance. 
There is an activity with relevant videos in the IT Learning Portfolio: visit skills.it.ox.ac.uk/it-
learning-portfolio and search for “thesis activity”. 

The resources you need 
Sample documents that you can use to experiment with will be made available, but you may 
like to bring along your own.  

The resources for most workshops, including any pre-course activity, are in the IT Learning 
Portfolio: visit skills.it.ox.ac.uk/it-learning-portfolio and search for “thesis activity”. 

Unless you have been told otherwise, in classroom workshops there will be a computer 
available for you to use with Word for Windows installed. 

You can use your own computer with your preferred app installed if you want to – just bear in 
mind that I am not an expert in every app (although I am sure that between us we will be able 
to sort out most problems!). 

https://skills.it.ox.ac.uk/it-learning-portfolio


  

 

About the tools you can use 

There are many applications that you can use to create a thesis; some make the task easier 
than others. The best apps are those that allow you to organize your document using 
automated tools – apart from Word here are two other solutions: 

Pages 
Pages is Apple’s word processor and is a good general tool. Doubts about its suitability for 
academic work persist with early versions unable to cope with portrait and landscape 
sections in the same document. It has excellent desktop publishing functionality but fewer 
tools suited for academic publishing. 

Open Office and Office Libre 
An open source, cross-platform tool. It has many of the features of Word and the interface is 
clean and user friendly. With patience it can produce documents that match those created in 
Word in terms of layout and typography. Worth exploring, and it exports to .docx files as a 
matter of course. 

  



  

 

Learning objectives 

This workshop has the following learning objectives. 

 Learning Objective One – Hierarchical numbering systems 

 Learning Objective Two – Footnotes and endnotes 

 Learning Objective Three – Cross references 

 Learning Objective Four – Table of contents 

 Learning Objective Five – Indexes 

 Learning Objective Six – Captions 

 Learning Objective Seven – Table of Figures 

 

  



  

 

Learning Objective One – Hierarchical numbering systems 
A structured document is more easily managed – and more accessible – if the headings and 
sub-headings are formatted by applying Word’s built-in styles Heading1, Heading2, 
Heading3 etc. 

Examine Welcome questions.docx to discover which styles have already been applied on 
various kinds of paragraph. Modify it so that the heading styles include outline numbering – a 
multi-level number scheme of your choice. 

With the insertion point on a Heading1 paragraph, you would click on the drop-down arrow on 
the Multilevel List button. Here you would choose one of the schemes from the List Library. It 
is very important to choose one of lists that has heading styles.  

Examine the effect on various kind of heading paragraph through the document. Notice that 
you have redefined the whole family of heading styles to include numbering. 

  



  

 

Learning Objective Two – Footnotes and endnotes 
Extra information may be included in a document, out of the main sequence of text, by 
inserting a footnote or endnote. A small marker (a number or punctuation symbol) is placed 
in the text, referring the reader to further information at the bottom of the page (a footnote) 
or at the end of the document (an endnote). Word can insert and manage these. 

We refer here to footnotes, however endnotes are managed in the same way - just make sure 
you select Endnotes when inserting them. 

In Wollstonecraft.docx, examine the footnotes that have already been inserted on pages 7 
and 8. There are some endnotes on page 9. Insert some more footnotes and endnotes on 
page 6. 

With the insertion point at a suitable place in the main text, choose the References tab of 
the ribbon and choose Insert Footnote. Notice the effect on numbering of the existing 
notes.  

For more settings such as numbering format, use the launcher  to open the Footnote and 
Endnote dialog (Mac users who do not have launchers should explore the main menus for 
equivalent). 

Now modify the footnotes to be all written in 12-point text.  



  

 

Learning Objective Three – Cross references 
In Draft Handbook.docx, under “10. Fees”, there are two cross references, one linking to Part 
7 and one to Part 9. Use Ctrl+click to test them. 

Insert some more cross-references in the text, for example: 

illustrated in Figure 4 

outlined under “Admission and Registration” 

as described on page 15 

If the document is to be edited further, the cross-references may then need to be updated. 

  



  

 

Learning Objective Four – Table of contents 
It is common to provide a table of contents near the start of a document, giving a list of the 
chapters or parts with the page where each begins. This would usually be placed after the 
title page but before the main content begins. 

Word can build and manage a table of contents in your document, provided that you have 
already structured the headings and sub-headings using styles. (Using and creating styles is 
covered in a separate IT Learning Centre course.) 

In Wollstonecraft.docx, examine the styles that have been applied to the headings. Build a 
table of contents where indicated on page 2. The Table of Contents dialog is found from 
References |Table of Contents. 

On page 12, insert more sub-headings between the paragraphs of Section IV, such as 
“Sensibility” and “Exclusive Affection”. Format these headings with the style Heading2. Now 
make sure the two new headings appear in the table of contents. 

  



  

 

Learning Objective Five – Indexes 
A formal document may include an index near the end: this may be a list of names, places, or 
key phrases which are used in the document, with the pages where they are to be found. 

Word can assemble an index automatically, although you must first go through the document 
marking the terms and phrases you want included. 

In Draft Handbook.docx, a number of phrases have already been index marked – you can 

see the {XE} codes if you turn on  Show/Hide. 

On page 6, mark “Graduate Studies Assistant” (para b) and “Trilby Library” (para d) for 
indexing. Then on page 58 insert an index. 

In the text, mark a couple more phrases, then update the index and make sure the new items 
do appear. 

  



  

 

Learning Objective Six – Captions 
A caption can be associated with each figure (or equation, table, photo etc.), with numbering 
that runs through a document. If this is done using Word’s automatic captioning tool, then 
the appropriate style will be applied. These captions are then used to assemble a list of the 
figures or other captioned items - for example this might be a Table of Figures, commonly 
included near the Contents of a document. 

In Draft Handbook.docx, some of the graphics already have captions. Examine the captions, 
noticing the style used automatically. 

For the first image in part 19 (Computing Services), insert a caption “Study tools”, by 
selecting the figure (or table, photo and so on) and using Insert Caption, on the References 
tab of the ribbon. Insert captions for some more figures that need them. 

Check the effect on the existing figure numbers – update figure numbers as necessary. 

  



  

 

Learning Objective Seven – Table of Figures 
Near the beginning of the Draft Handbook.docx document, create a list of the figures, giving 
figure numbers and page numbers. Use the hyperlinks in the table of figures to move around 
the document, visiting each graphic in turn. 

  



  

 

Further information 

Getting extra help 

Course Clinics 

The IT Learning Centre offers bookable clinics where you can get pre- or post-course advice. 
Contact us using courses@ox.ac.uk. 

Study Videos from LinkedIn Learning 
On our website, you will find our collection of self-service courses and resources. This 
includes providing LinkedIn Learning video-based courses free to all members of the 
University. Visit skills.it.ox.ac.uk/linkedin-learning and sign in with your Single Sign-On (SSO) 
credentials.  

Some courses recommend pre- and/or post-course activities to support your learning. You 
can watch the online videos anywhere, anytime, and even download them onto a tablet or 
smartphone for off-line viewing.  

About the IT Learning Portfolio online 

Many of the resources used in the IT Learning Centre courses and workshops are made 
available as Open Educational Resources (OER) via our Portfolio website at 
skills.it.ox.ac.uk/it-learning-portfolio. 

Find the pre-course activity for this course in the IT Learning Portfolio: visit  
skills.it.ox.ac.uk/it-learning-portfolio and search for “thesis activity”. 

About the IT Learning Centre 
The IT Learning Centre delivers a programme of digital skills courses, which are provided in 
our teaching rooms and online, and we give you access to thousands of on-line self-service 
courses through LinkedIn Learning. 

Our team of teachers have backgrounds in academia, research, business and education and 
are supported by other experts from around the University and beyond. 

Our courses are open to all members of the University at a small charge. Where resources 
allow, we can deliver closed courses to departments and colleges, which can be more cost-
effective than signing up individually. We can also customize courses to suit your needs. 

Our fully equipped suite of teaching and training rooms are usually available for hire for your 
own events and courses. 

For more information, contact us at courses@it.ox.ac.uk. 

About IT Customer Services 
The IT Learning Centre is part of the Customer Services Group. The group provides the main 
user support services for the department, assisting all staff and students within the University 
as well as retired staff and other users of University IT services. It supports all the services 
offered by IT Services plus general IT support queries from any user, working in collaboration 
with local IT support units. 

mailto:courses@ox.ac.uk
https://skills.it.ox.ac.uk/linkedin-learning
https://skills.it.ox.ac.uk/it-learning-portfolio
https://skills.it.ox.ac.uk/it-learning-portfolio
mailto:courses@it.ox.ac.uk


  

 

The Customer Services Group also offers a data back-up service. Customer Services is 
further responsible for desktop computing services – for staff and in public/shared areas – 
throughout UAS and the Bodleian Libraries. 



  

 

Course Slides 

The following pages contain images of the slides used in the presentation. The original 
PowerPoint presentation file can be downloaded from the same place where you obtained 
this course book. 
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Word:
Thesis and book design

Pamela Stanworth
pamela.stanworth@it.ox.ac.uk

Activities for you to practice today
In the coursebook
Work at your own pace!
Be selective

Videos with today’s topics in 

Follow-up work
Continue with exercises after the session
Bookable Course Clinics later

Resources for your learning

Today, the exercise files are in 
the Documents folder

Word 2019 in teaching rooms
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Course topics

Part 1
Automatic numbering

Footnotes & endnotes
Cross references

Index and table of 
contents

Figures and captions

Part 2
How templates work

Create or modify 
templates

Making up a book

Re-structuring a large 
document

Getting started

Numbered headings
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Button on the Home tab 
Choose a number scheme

Promote and demote individual paragraphs 
using 

Multi-level numbering
- direct format -

Select/click in the text
Display the Styles task pane

Choose a heading style

Text is re-formatted
All text with that style
will have the same formatting

Applying a style

Click in a paragraph that has heading1 style already
Click

Choose a numbering scheme
with “heading” in the preview

All heading styles are re-defined
to use this numbering scheme

Numbered headings
using styles

11
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On the Multilevel List menu

Choose Define New Multilevel List

A custom numbering scheme

Look at Learning Objective One

Resume at 10:15 please

Word: Managing your thesis

Download the files 
(and more) from the 
IT Learning Portfolio at

skills.it.ox.ac.uk/it-learning-portfolio

Find the resources for this workshop 
in our IT Learning Portfolio
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Footnotes and Endnotes

Footnotes - at the foot of the page

Endnotes - at the end of a document 
(or section)

There is special software for creating 
bibliographies and reference lists (eg. EndNote)

Footnotes and endnotes





on the References tab
Choice of numbering scheme or symbols
Continuous numbering 
or Restart on each page (or section)

Use the reference symbols to browse

Numbers re-count when text is rearranged

Creating footnotes and endnotes

17
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Symbol and note text use built-in styles
Footnote text, Footnote reference
Endnote text, Endnote reference

Modify a style to suit your document

Footnotes and endnotes use styles

Cross-references

Pointing to a place elsewhere in the document

Cross-reference can point to a heading, bookmark, 
footnote, endnote, equation, figure, table, title …

Cross-references

“as defined in 
Equation VI”

“details given 
in Table 16 

below”

“as explained in 
the Conclusions”

“as described 
in Part 4”
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Cross-ref can point to…

a heading a footnote
an endnote

… or an invisible bookmark

a figure caption
table caption etc.

A cross-ref is a field code

Update often

Cross-referencing

Look at Learning Objectives Two and Three

And take a break…

Resume at 11:00 please

Word: Managing your thesis
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Tables of Contents

References | 

Choose:
Showing page numbers
Right-aligning
Tab leader
Format
Levels to include

Table of Contents

Table of Contents options

Choose which styles are 
to build the ToC

Re-define the styles 
used to display the ToC

Navigating
<Ctrl>+click to jump to a heading
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Word uses field codes for automatic features
e.g. Table of Contents, Index, Cross-reference
EndNote uses field codes for citations and bibliography

Updating or or <F9>
Not automatic!

Show all field codes using <Alt+F9>
Replace a field code with its result 
(ready for publisher) <Ctrl+Shift+F9>

Field codes

Index

Indexing

29
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Captions

Captions for images and diagrams

ScoreCity

200Agrigentum

240Bononia

500Mediolanum

Table IIDiagram cFigure 1

Select a figure

References | 
Choose a label, position, numbering etc.

Create a new label
using

Creating a caption

32
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Lists can be based automatically on 
captions

Separate lists for Figures, Tables, Maps  etc.

References |

Table of Figures

More help with documents

Word: Good practice in document design
Building your long documents

EndNote referencing series

See the schedule online

Other related courses
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Download the files 
(and more) from the 
IT Learning Portfolio at

skills.it.ox.ac.uk/it-learning-portfolio

Find the resources for this workshop 
in our IT Learning Portfolio

Choose from the remaining Learning 
Objectives

Finish at 12:00 please

Word: Managing your thesis

Acknowledgements

This presentation is made available by Pamela Stanworth
under a Creative Commons licence:

Attribution-NonCommercial-ShareAlike
CC BY-NC-SA

pamela.stanworth@it.ox.ac.uk

16

39

40


	TX003_Protobook_Documents_ManagingThesis
	The small print
	Prerequisites
	Copyright
	About the workshop designer
	Revision history

	About this workshop
	What you will learn
	What you need to know
	The resources you need

	About the tools you can use
	Pages
	Open Office and Office Libre

	Learning objectives
	Learning Objective One – Hierarchical numbering systems
	Learning Objective Two – Footnotes and endnotes
	Learning Objective Three – Cross references
	Learning Objective Four – Table of contents
	Learning Objective Five – Indexes
	Learning Objective Six – Captions
	Learning Objective Seven – Table of Figures

	Further information
	Getting extra help
	Course Clinics

	Study Videos from LinkedIn Learning
	About the IT Learning Portfolio online

	About the IT Learning Centre
	About IT Customer Services

	Course Slides

	blank intentionally
	TX003_Slides_Documents_ManagingThesis

